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CHAPTER II 

LITERATURE REVIEW 

2.1 The History of ‘Taman Wisata Alam Punti Kayu’ 

 Taman Wisata Alam Punti Kayu is conservation forest which is used as 

tourism place. Historically, this park was constructed by the Dutch. On July 21st 

1937, it was determined as forest area and some areas are Tanah Negara Bebas. 

the width of this area is 98 hectares that cultivated by various kinds of trees such 

as Pinus merkusii (pine), Swietenia sp (mahoni), Alstonia sp (pulai), Albizia sp 

(albizia), Paraserienthes sp (sengon), Eucalyptus sp (ampupu), Acacia sp (acacia), 

Melaleuca leucadendron (gelam/kayu putih), and Bambusa sp (bamboo). 

However, 80% of the area is cultivated by pine trees. In 1960 the name of this 

park was Taman Sari, then transformed into Taman Syailendra. Previously, 

Balaputera Dewa Museum was part of this park and became the entrance to 

Taman Wisata Alam Punti Kayu. Then, the land was donated and left over 50 

hectares now used as Taman Wisata Alam Punti Kayu. In accordance with the 

letter of approval of the Director General of Forestry (Direktur Jendral 

Kehutanan) Number: 133/DJ/I/1980 dated 26 April 1980, the park area was 

reduced to 48 hectares. It is used for the purposes of Provincial Government 

(Provincial) South Sumatra, Sriwijaya Military Command II and police dormitory. 

 No one knows for sure the meaning of the name of Punti Kayu itself. In 

accordance with the Ministerial Decree dated March 7, 1985 No: 57/KPTS-

II/1985. Since then, Punti Kayu was designated as forest tourist (conservation 

forest). Next, on March 15th 2001, it was chosen as natural tourism park (Taman 

Wisata Alam) and it was determined in SK. Menhut No. 76/Kpts-II/2001. Finally, 

it was determined as natural tourism park (Taman Wisata Alam) accordance with 

SK Menhut No. 9273/Kpts-II/2002 on October 07th 2002. This park was managed 

by PT. Indosuma Citra Putra for 30 years since 1995. The land that can be 

affected as a recreation area is only 39.9 hectares, while the rest are difficult to 

develop because it is the conservation area where the existence of trees is 

inviolability.  
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2.2 Promotion Media 

Promotion is communication activities where organizations try to 

influence the tourism organizers of the audience where the sale of its products 

dependent (Pitana and Diarta, 2009), while MacCarty in Yoeti (2004) said that 

promotion is a method of communication information aimed at the target markets 

about products or services available on In The Right Place at The Right Time.  

Beside Kotler (2000) argued that promotion is a process of informing, 

persuading and influencing a consumer to make choice of the product to be 

bought. In line with Kotler, Sigit (2007) said that promotion is the activities of a 

company that is designed to inform, persuade, or remind others about the 

company are concerned with the goods and services offered by it. 

According to Pitana and Diarta (2009) there are four steps to start the 

promotion. That are (1) promotion the goal setting; (2) establish some alternative 

statements relating to differences promotion mix strategies that allow to achieve 

the goals; (3) create a solution in the form of a series of measurable promotion 

purpose by considering the target audience, things will be communicated, duties 

and responsibilities, and the time used; and (4) assessment of promotion plans to 

fit the budget available, human resources, and time required. 

Kotler (2005), said that the elements of promotion mix consists of five 

main tools, namely: (1) Advertising; (2) Sales Promotion; (3) Public relation and 

publicity; (4) Personal Selling; and (5) Direct marketing. Advertising is non-

personal presentation, promotional ideas, promotional products or services in a 

particular sponsor paid (Kotler, 2005). The functions of advertising are 

Informative, Persuading, Reminding and Entertainment. 

According to Basuki (2000), Media communication/promotion devided 

into five. That are printed material, outdoor, electronic, display and special offer. 
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No Media Sample 

1. Printed Material/Media 

Poster (indoor and outdoor), sticker, book 

cover, folder, leaflet, brochure, catalog, 

magazine, newspaper, and so on. 

2. Outdoor Media 
Banner, neon box, neon sign, bilboard, and so 

on. 

3. Electronic Media 
Radio, television, internet, film, video 

program, computer animation and so on. 

4. Display Media 
Windows display, point of purchase, floor 

stand, and so on. 

5. Special Offer Media 
T-shirt, hat, glass, umbrella, souvenir, bag, and 

so on. 

Table 2.1 Media communication/promotion 

Source: Basuki (2000) 

2.3 Tourist Satisfaction 

Satisfaction is created by the comparison of the customer’s expectation 

before and after consumption (Sadeh et al, 2012). According to Chen and Chen 

(2010) in Sadeh at al (2012) argued that satisfaction of tourists are caused by two 

different dimensions. That are pre-travel expectations and post-travel experiences. 

If the expectations before visiting with experince after visiting highly good result 

it can be concluded that the touris will visit the tourism object again (Huang et al, 

2006; Hui et al, 2007; and Su and Fan, 2011). In other words touris will be a loyal 

customer. On the other hand, both practitioners and academics understand that 

consumer loyalty and satisfaction are inextricably intertwined (Lee et al, 2011). 

There are five things that should be considered in supporting the 

development of tourist destination; they are tourist, transportations, attractions, 

services facilities and promotions-informations (Yoeti, 2008), while (Berkowitz, 

2004) explained there are four factors that influence consumer decisions, these 

factors are the marketing mix, socialcultural, psychology and situation. In all four 

of these factors are the components that affect consumer decisions, such as factors 
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of marketing mix (Product, Price, Place, Promotion, Process, People and Physical 

Evidence), socio-cultural factors (social class, reference groups, family, culture, 

and subcultures), psychological factors (motivation, personality, perception, 

learning, attitude and lifestyle), and situational factors (task Purchase, Social 

surroundings, Physical surroundings, Temporal effects and antecedent states). 

2.4 Definition of Design and Graphic Design 

Design can be said as a draft or plan to make product, interior, graphic or 

textile. The same meaning listed in Webster's Encyclopedic Unabridged 

Dictionary of English Language (2003). Here it is said that the design is to the 

make drawings, preliminary, sketches or an object, work of art, decorative 

scheme, and Basuki in Pujirianto (2005) also has same idea about definition of 

design. He said that design is stretches in dots and lines form which is related with 

printing activities. 

In this report, design intended by the writer is graphic form, so the 

definition of graphic design here is the process of designing an object in visual 

form, in other words design is the process of making a picture. This is 

strengthened by several experts’ statements about the definition of graphic design. 

According to Wibowo (2013), graphic design is the design of communication 

through pictures. Aligned with Wibowo, Hendratman (2008) said that a graphic 

design is thinking process that is realized in the images form. 

 A design must have elements of aesthetic, functional, flexible, realized, 

economic and market (Wibowo, 2013). So the design can influence the reader to 

see at once. A graphic designer should be able to master about nirmana, 

typography, coloring and software (Wibowo, 2013) to make the design qualified 

and have high artistic value. 

According to Wibowo (2013), nirmana is the arrangement of visual 

elements such as point and line become unity in harmony. Line in nirmana is 

dividing into three kinds that are straight line, curve line and combination line. 
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The principles about visual communication of graphic design in nirmana are 

unity, balance, proportion, rhythm and domination (Wibowo, 2013) 

In design graphic, a designer should know well about the guidelines of 

typography used, that are readability, cleanlines, visibility, and legibility 

(Wibowo, 2013). The characteristic of texts are: 

No Text Characteristic 

1. 
Italic Text It makes the eye become interesting with the words 

because it is contras with normal text. Italic cannot 

be used in long words because it will make the word 

hardly to read. Italic text usually used in foreign 

word. 

2. 
Bold Text It is usually use on title or subtitle. It will make less 

focusing when it is over used. 

3. 
Underlined The function of underline text is showing the 

important things and also used for hyperlink on web. 

4. 
Coloring The function of color text is same with italic and 

bold, that is make the word become interesting. 

Color text is hardly to use because a designer should 

understand about color composition. 

5. 
Capital/Uppercase Uppercase uses to show important things but it is 

hardly to read because in uppercase the low and high 

size of word is same. 

Table 2.2 Characteristic of Text 

Source: Wibowo (2013) 

According to Brewster Theory in Wibowo (2013), he argued that colors 

are divided into four types that are primary, secondary, tertiary and neutral.  

a) Primary color 

It is base color without combining with other colors. Primary color 

is arranging into three colors that are red, blue and yellow. 
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b) Secondary color 

It is combining primary color 1:1. For example green is combining 

color between blue and yellow, and purple is combining color 

between red and blue. 

c) Tertiary color 

It is primary color that is combined with secondary color. For 

example pale green is combining color between green and yellow. 

d) Neutral color 

It is kinds of color that is combining from primary, secondary and 

tertiary color with proportion 1:1:1. It is divided into two kinds. 

Hot color and cold color (hue). 

Every color has different meaning, this are the psychology of color according to 

Hendratman (2008): 

No Colors Psychology 

1. Red Sign of struggle, desire, active, aggressive, dominant, 

competition, bravery, energy, warmth, love, dangerous. 

Combining between red and green is sign of christmas 

while combining between red and white means happiness 

in oriental culture. 

2. Blue Sign of calm and quite, trust, safety, technology, 

cleanliness, and tidiness. It usually used for bank logo in 

United State. This color give trusty to the costumer. 

3. Green Sign of nature, health, dream, luck, proud, authority. 

People who likes this color generally like to get praising 

and give advising. 

4. Yellow Sign of optimistic, hope, unbelief, change/not constant, 

happy and enjoy. Hinduism is consider sacred this color. 

5. Purple Sign of spiritual, mystery, noble, arrogant, and rude. 

Characteristic of this color is careless but always have 

expectation. 
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6. Orange Sign of energy, spirit, fresh, balancing, cheerful, and 

warm. It usually used for orange drinks and use as a sign 

of cheap product. 

7. Brown  Sign of soil/earth, comfortable, stamina, struggle, egoist, 

intolerance, pessimist to the prosperity and happiness of 

future. 

8. Grey Sign of intellect, futuristic, millennium, simpleness and 

sadness. This color did not show clear meaning and it is 

free of psychology tendency. 

9. White Sign of pure/holy, clean, exact, and true. In India and 

China, this color is death sign while in others county it is 

sign of wedding dress. 

10. Black Sign of powerfull, the evil, sophisticated, death, mystery, 

fear, sorrow and elegant. Black product box symbolize of 

elegance, wealth and sophisticated while in western culture 

it is sign of death. 

Table 2.3 Psychology of color 

Source: Hendratman (2008) 

 

 There are four types of working basic on graphic design (Wibowo, 2013), 

that are image, type, image-type, and symbol-logo-logotype design. Firstly is 

image design. Image design means designing a product using the image as a 

messenger but a designer often give a little word to clarify what is the meaning of 

image. People would guess the meaning of the images according to their mood or 

experience. Secondly is type design. Designs here prefer to use words than 

pictures but sometimes the words look likes a picture because designer arranges 

and edits the words.   
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Picture 2.1 Type Design 

Source: http://cdn.instantshift.com 

Next is image-type design. It is the design that is combining image design 

and type design. It is intended to make the design has good balancing between 

image and type. And the last is symbol-logo-logotype design. It is used as identity 

of the product or company. This picture below is example of logotype design. 

 

Picture 2.2 Symbol-logo-logotype Design 

Source: Personal Documents 

In this project, the writer use image-type design in the brochure of Taman 

Wisata Alam Punti Kayu. Image-type design means designer often combine 

images and typography to communicate a message to the readers. It aims to give 

the look and complete information. So designer establishes the best balancing 

both of them. 

2.5 Definiton of Brochure 

Brochure is one of the media promotions which are made by paper that 

consists of complete information and offers about a service or product. This 

statement is strengthened by Kamus Besar Bahasa Indonesia, where it is stated 

that the brochure is prints leaflet containing a brief description but complete 

(about the company or organization). Furthermore, Yoeti mentioned that brochure 

is printing publication by using relative good paper, good layout arrangement with 

all the potential to be promoted (1985).   
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A type of brochure folding which is used by writer is tri-fold (letter fold). 

According to Pujirianto (2005), he classified form of brochure folding into 

thirteen, that are Four Pages, Six Pages Roll, Six-Pages Accordion, Eight-Folds 

Rolls, Eight-Folds Accordion, Eight-Pages Folding Maps, Eight-Pages Gate Fold, 

Eight-Pages Parallel Fold, Twelve-Fold Pages Back And Forth, Sixteen Pages of 

Alternating Wide, Sixteen-Page Booklet Sewing Volumes, Twenty-Four Pages 

Booklet-Sewing Volumes, Thirty-Two Page Booklet Full Volumes. Beside 

accrording to www.bradenprint.com, there are twelve types of folds, that are Half 

Fold, Letter Fold (tri-fold), Z-Fold, Half Letter fold, Two Parallel Fold, Accordion 

Fold, Half + Z-Fold, Gate Fold, Barrel Fold, Z-Fold With Angled Trim, Eight 

Page Right Angle Fold, and Sixteen and Thirty-Two Page Right Angle Fold.  

 

 

Pictures 2.3 Brochure folding 

Source: http://www.arnoldcreative.net/brochures.html 

 Based on www.kiosdigital.net, this website mentioned that brochure has 

three functions that are: 

a) Informative Function 

The fuction of brochure is informing to all the costumers about the 

company, new products, services, and so on. 

b) Advertisiment Function 

The fungtion of brochure is promoting the products or services. 

c) Identification Function 

The fungtion of brochure is as a marketing concept, if the brochure 

is interesting and influencing the reader they will be identified the 

http://www.bradenprint.com/
http://www.arnoldcreative.net/brochures.html
http://www.kiosdigital.net/
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company and want to know more about this company by read the 

brochure which was created before. 

2.6 Materials and Tools Needed to Make Brochure 

2.6.1 Materials 

The material of this brochure is using art paper with size A4 120 grams. 

The characteristics of this paper are smooth surface on both side and clean 

white paper color. This paper is not waterproof and if it exposed by water it 

will be sticky (stuck with each other). 

2.6.2 Tools 

The tools needed to design this brochure are: 

a) Computer or laptop with Software CorelDraw 

The qualification of computer is Windows XP or Windows Vista or  

Windows 7 that minimal has an Intel Pentium 4 spec or equivalent, 

1 GB memory, screen resolution of 1024 x 768 pixels, as well as 

DVD drives and the empty hard drive capacity of at least 1.5 GB for 

installation. 

b) Mouse 

It is used for making the position of object more precision than 

using touchpad in laptop. 

c) Printer and ink 

It is used for printing the design with any color. Types of ink are art 

paper ink. The advantage of using this ink is drying fastly. 

d) CorelDraw Books and Tutorials 

It is used for helping the writer to make brochure. The writer used 

books from Jayan (2009) and also Hendratman (2008). It is consist 

of tips and tricks to make a good brochure. 

2.7 The Procedure of Making Brochure 

According to definition of brochure and design, the writer conclude that 

brochure design is the process of making media promotion which is made by 

paper that consists of complete information and offers about a service or product. 
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In designing this brochure, the writer used software CorelDraw. It is one of vector 

graphics editor. In making brochures people needed some standard way. Before 

going any further, the writer will describe the tools that are commonly used in the 

process of making brochures of Taman Wisata Alam Punti Kayu. 

 

Picture 2.4 CorelDraw Tools 

Source: www.tetesanpena27.blogspot.com  

This table below is show what tools are commonly used in making brochure.  

ICON TOOLS FUNCTION 

 

Pick Tool to choose or select and adjust the size, tilt, and 

rotate objects 

 
Shape Tool to edit the shape of the curve object 

 
2-point line Tool to draw a single line without curves 

 

Rectangle Tool to draw a square and box 

 
Elliptical Tool to draw an oval or circle 

 

Text Tool to write directly on the screen word as a 

paragraph or artistic text 

 
Fill Tool Outline tool as well as when we choose the Fill 

http://www.tetesanpena27.blogspot.com/
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tool fly out will appear and give you quick access 

to some facilities, such as the Fill dialog box 

(Uniform Fill, Fill Fountain, etc.) 

Table 2.4 CorelDraw’s Tool 

This is pictures of menu and property bar which is commonly used by 

writer in CorelDraw. 

 

 

Picture 2.5 Menu bar and Property bar 

This table show about the function of each menu and property bar: 

MENU BAR FUNCTION 

File > New Used for making new page 

File > Save Used for save the project in CDR (CorelDraw) form 

File > Import Used for insert pictures or objects 

Arrange > Order Used to put the object back or in front of other object. 

Arrange > Convert 

to Curve 

Used for making the object become curve 

Effect > Power clip 

> Place inside frame 

Used for place the object inside the other objects 

Text > Fit Text to 

Path 

Used for making the text fit with the path 

Page Size Setting the size of paper 

Page Dimensions Specify the width and height of the page 

Orientations To choose the orientation of paper (landscape or 

portrait) 

Drawing Units To choose a unit of measure for the document 

Table 2.5 Menu Bar in CorelDraw 
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In designing brochure, designer should know about CorelDraw first. Besides from 

book, designer should familiar in using all tools. Here is the standard procedure of 

making the brochures according to Jayan (2009:2-11). Firstly is make new page 

than setting paper’s size by property bar. Change the unit into millimeters and 

setting the paper size to 334.0mm X 215.9mm. 

 

Picture 2.6 Create New Page 

Secondly is setting the guideline. After we make a new page and setting 

the paper size, we should set the guideline. It is helping line when we would like 

to put some object. The guideline would help the position. When we choose 

method snap to guideline we will get accurate position. Setting the method snap to 

guideline in menu ‘view’ then ‘snap to’ choose ‘snap to guideline’ or click in 

property bar ‘snap to guideline’.  

 

 

Picture 2.7 Snap to Guideline 
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The way for setting the guide is double click in the ruler. Then open the 

guideline and set vertical with 111.333 than click add. After that add 222.666 and 

click add again. Click ok if we want to close. In the same way, we add horizontal 

guideline. Adding the box with 107.500 then click add and fill it again with 

number. After finishing the number of guideline click ok. 

 

Picture 2.8 Guideline setting 

 

Next step is making a shape (square) in the right angles. After that click 

menu ‘Arrange’ then ‘Convert to Curve’ or ctrl+Q. This step will change the 

shape become curve. Then, use shape tool and right click in the shape then 

‘curve’. Still use shape tool, curve the shape with ‘handle point’. Coloring the line 

with black then duplicated the shape twice and setting the size and color. 

 

Picture 2.9 Handle Point 
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Next is making a square shape with 10% black by rectangle tool. Then 

click shift+page down to make the shape inside the curve. 

 

Picture 2.10 Rectangle Tool inside the Curve 

 

 Adding the brochure with import a picture by ctrl+i. Resize the picture and 

put it in the backside of the curve but in front of 10% black shape by shift + page 

down than ctrl + page up once. Click menu ‘bitmaps’ then ‘Bitmap Color Mask’ 

to make white color in the silhouette disappear. 

 

Picture 2.11 Silhouette 

 Last step is making triangle shape by using polygon tool. Change the color 

to 30% black and click menu ‘Arrange’ then ‘Transformations’ and choose 

‘Rotate’. Click triangle shape and click angle in rotate box to 15% and duplicate it 
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into the triangle look as a circle then click apply. Selection all triangle by ctrl+g 

then click menu ‘effect’ then ‘Power clip’ and choose ‘Place inside Container’ 

and edit the position. 

 

Picture 2.12 Triangle Rotation 

 


